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Overview

The  HardingFPA-X  System  is  a  distributed  version  of  the  standalone  HardingFPA  Flash  and  Pattern
Analyser.  It operates in a similar way, but analyses file-based workflows instead of tapes.

This  manual  describes  the  use  of  the  client-side  components  in  the  HardingFPA-X  System.  These  are
intended  for  users  to  submit  jobs  and  view  the  results  of  analysis,  while  the  system  takes  care  of  the
analysis, possibly on a different computer on a local area network.  This manual does not include detailed
installer/administration  instructions  for  the  system.   These  can  be  found  in  the  HardingFPA-X
Administration Manual.

The  client-side  of  the  HardingFPA-X  System  consists  of  two  applications,  namely  HardingFPA-X  Submit
and HardingFPA-X Viewer.  These can be found in Applications → HFPA-X on Mac OS X, and in the Start
Menu under HFPA-X on Windows. 

Jobs can be submitted using the Submit application or by dropping the movie files into watch folders (see
your  administrator  to  find out  if  you  have  watch  folders  enabled and where  they  are).   These  jobs  are
then posted via the central database into the Job Queue, where they are picked up by analyser computers
which analyse the material and write out results files which may then be viewed using the HardingFPA -X
Viewer.

This  manual  covers  both  the  Mac  OS  X  and  Windows  versions  of  the  HardingFPA-X  Submit  and
HardingFPA-X Viewer, which operate in an identical manner.
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Licensing

Your computer must be licensed to run the HardingFPA-X Client applications by your administrator using
the HardingFPA-X Licence Server.  If you are not licensed, you will see the following error dialogue box:

From this dialogue box you may specify the location of the server manually if it can not be found
automatically.  Please see your administrator for more information.
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Version 3 Analysis Algorithms

If your system is running HardingFPA-X Analyser Version 2.0.0 or above, the analysis now features new
analysis algorithms, which are better tuned to High Definition and File-based work.

 They are better suited to subtle changes in the image data, and provide much closer results when testing
the same material repurposed either into a different video format, or encoded with a different codec. 
The main differences between the legacy algorithms and the new ones are detailed below:

Differences Between v2.5 and v3.0 

Different Graph Scaling

The HardingFPA-X generates risk values using the same range as its predecessor (i.e.  0 to 3.4) but
displays the graphical data using a revised vertical scale. This modified scale allocates much more vertical
space for risk trace warnings and diagnostic trace steps but only displays risk traces up to the value of 3.0.
Risk traces values from 3.1 to 3.4 are still logged as part of the results files but are graphically displayed
capped at 3.0.

(left) Version 2 and (right) Version 3 Graphing

The Squiggle
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The HardingFPA-X gives enhanced visual diagnostics when an incoming transition coincides with an
outgoing transition from one exactly second earlier. The new version 3 algorithms insert a squiggle (see
below) to indicate when the diagnostic trace has simultaneously gained and lost a transition over the
most recent second between video frames.

Analysis Results

The HardingFPA-X gives results which are broadly similar to those generated by version 2.5.  The figure
below shows the results of both versions when analysing the same video input under the same
guidelines:
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However, the results between the two versions will not be identical. The HardingFPA-X will, in general, be
more lenient to complex, rapid motion:

... but more strict to examples of powerful, localised flashing:
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Most importantly of all, the HardingFPA-X  has been designed to be as format-agnostic as possible.
Changes in file formats or codecs will alter the underlying video data even if these changes are not
visually apparent. Here, the same video has been encoded at the same resolution using two different
codecs.  The absolute differences between the two images are shown in the third image as deviations
from mid grey. 

The new version 3 algorithms generate highly consistent results from different image resolutions and
frame rates.  Here, the same movie has been analysed in 720x576i50 and 640x480i60 formats with highly
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consistent results. The only noticeable difference is the different horizontal graph scales as a result of the
different frame rates.

The  graph  below  shows  three  sets  of  luminance  flash  risk  results  of  the  same  movie  analysed  in
SD-576i50,  HD-720p50  and HD-1080i50  formats.   The results  are sufficiently similar  it  is  difficult  to  see
that the graph contains three separate traces:
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SD Legacy Mode

The HardingFPA-X  has a version 2.5 legacy analysis option for when comparisons with earlier HardingFPA
analyses are necessary (i.e. those that have come from versions 1.x of the HardingFPA-X, and to have
some level of compatibility with HardingFPA V2.5x SD-SDI Standalone tape-based systems).

If your administrator has enabled this, it will be apparent in both the Viewer interface and the generated
PDF certificate (see below).
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HardingFPA-X Submit

The HardingFPA-X Submit  is essentially the main application on the client side of the system.  From this
application you can submit jobs, view the job queue, see all completed jobs, view the PDF certificate and
graphical  depictions  of  the  results.   The  Submit  will  automatically  launch  the  appropriate  software  for
results viewing.
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Settings

It  is  important  to  make  sure  the  settings  are  correctly  configured  before  starting  to  use  the  Submit
application, otherwise the jobs submitted will not be analysed, and it will not be possible to view the job
database.  The settings screen is found by clicking Tools → Settings and is shown below.

The HardingFPA-X Submit settings screen

The meaning of these settings is given below:

Root Path:  This is the location of the root of your storage system. This folder will typically be the root of
the SAN or shared network drive where your media is  kept.   This is  the mount point that refers to that
location from the current computer only, and might be different on different computers.  Please contact
your administrator if you do not know what this should be set to.

Results Folder:  This is the location where the Analysers in the system write the results to.  This is required
for the Submit application to automatically launch the Viewer to view the results of movie analysis.

The Database Settings describe the host name and port of the HardingFPA-X database, which contains all
of the information required for the system to operate, including the list of jobs.  The Host Name  can be
either an IP address or the computer name.  Please obtain this information from your administrator.  Be
aware that  if  these settings are modified,  the  Submit  will  need to  be  restarted for  the  changes  to  take
effect.  Additionally, if these settings are set incorrectly, the Submit may take a longer time than usual to
start up as it looks for the database.  Here it is also possible to choose whether you would like Submit to
refresh the tables automatically, and at what time interval (the minimum interval is 5 seconds).

The Options section features one further option, "Enable Submit to view jobs from all users", which must
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be checked in order to  allow the application to  show jobs from other  users  in  both  the  Job Queue  and
Completed Jobs tabs.  If this is not checked, or has not been checked by your administrator then you will
only be able to view jobs that were submitted using Submit on the computer and user name combination
that you are currently logged in as.

The Double Click on Completed Job setting defines what you would like to happen when you double-click
on a completed job in the Completed Jobs tab.
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User Interface

The interface of the HardingFPA-X Submit is split into two tabs.  The Job Queue (described below) lists all
of the currently pending jobs in the system, and the Completed Jobs list shows all of the completed jobs
for the last 14 days.  

The Job Queue displays the jobs in the order in which they will be analysed (although some analysers may
be set to only analyse jobs of a certain length, so this may not be the exact order).  If jobs appear to be
out of order by Job ID, it may be that the administrator has modified the priorities of one or more of the
jobs in the queue.  Job priorities may only be changed by administrators.  

If the setting is configured in the settings screen, you may click "Show jobs submitted by all users" in order
to see all jobs in the system.  If this is not checked, or has not been checked by your administrator then
you  will  only  be  able  to  view  jobs  that  were  submitted  using  HardingFPA-X  Submit  using  the
computer/user  name combination that  you  are  currently  logged in  as.   Please  note  that  this  filter  only
applies to jobs submitted with the Submit  application, and not those that you have dropped into watch
folders.

"ETA to next job" shows the estimated waiting time until your first job in the list will be analysed.  If you
do not have any  jobs in the  Job Queue,  the ETA shows the estimated time for all  of  the jobs in the Job
Queue to be completed.  The format of this time is hours : minutes : seconds.

On both tabs there are two buttons, Refresh and Submit Movies.  Refresh can be used to force a refresh of
the current tab.  Submit Movies is used to enter a new job into the job queue.
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The Completed Jobs tab on HardingFPA-X Submit

 



Page 18

 © 2010 Cambridge Research Systems Ltd.

HardingFPA-X User's Manual

Submitting Jobs

In order to submit a new job, click on the Submit Movies button.  A “Submit Movies” dialogue will appear,
as  shown  below.   From  this  you  may  browse  to  the  file(s)  you  wish  to  submit  as  jobs.   Multiple  file
selection is supported.  The movie file(s) you choose must be able to be accessed by the Analyser(s) in the
system, and therefore should be in a subfolder of your Root Path.  

The  Analyser  computers  will  analyse  any  movie  file  for  which  the  computer  it  is  installed  on  has  the
codec, otherwise the Analysers will dismiss the job.  If in doubt, contact your administrator.

Submitting movies in HardingFPA-X Submit
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Viewing Results

The Right-click menu for the Completed Jobs tab (HardingFPA-X Submit)

Provided a job completed correctly, with no errors, you may view the results of the job by right-clicking
on the job line in the Completed Jobs table.  The context menu shown above will then be displayed.  View
Results  will  launch  the  HardingFPA-X  Viewer  in  order  to  see  the  graphical  depiction  of  the  results,  and
View PDF will launch a third party PDF viewer to view the PDF certificate.  These actions can also be tied
to the double click action by selecting the option in the Settings screen.  The Results Folder setting must
be set correctly for this to work.
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HardingFPA-X Viewer

The HardingFPA-X viewer  is  used on  the  client  side  computers  of  the  HardingFPA-X  System  in  order  to
view the results for completed analyses.  It is typically launched via the HardingFPA-X Submit application,
by Right-clicking on a completed job and selecting View Results, but may also be launched separately – in
which case  results  files  (PAR,  PAP  and  PAM)  may  be  opened  using  the  Open File  button  or  menu  item
(located under the File menu).  
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The Main Screen

The HardingFPA-X Viewer screen displays a graphical representation of the characteristics of the analysed
clip,  and some additional advanced diagnostic information. This allows the user to quickly and efficiently
view the locations of failures or cautions in the source material, and optionally play back the areas around
these failures to aid in rectifying the offending material.

The main HardingFPA-X Viewer window

Once  a  set  of  results  (PAR,  PAP  and  PAM  files)  has  been  opened  with  the  HardingFPA-X  Viewer,  the
screen will  appear similar  to  that  displayed below.  A timeline is  displayed at  the bottom of  the screen
detailing  the  timecodes  of  the  corresponding  frames  and  whether  the  frame  is  a  failed  frame.   Failed
frames  are  surrounded  in  blue.   Please  note  that  images  are  only  displayed  in  certain  circumstances
around failure/caution regions and if no image is present then the frame will contain the text “No Image”.
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A large version of the thumbnail at the current cursor position is shown on the top left hand side of the
screen.

The results can be browsed either by dragging the graph display left and right or by moving the scroll bar
located at the bottom of the screen.  To the right of this scroll bar there are two buttons which will move
the cursor to the next or previous failure.
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The View Menu

The Viewer’s View menu

Within this menu are the options to zoom the graph in and out in order to focus on certain areas of the
results, as well as the options to show or hide the diagnostic traces and the caution band from the graph.
 Zooming in and out may also be performed by the Zoom In and Zoom Out buttons underneath the graph
or by pressing F1 and F2.
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Analysis Information

The  table  on  the  left  hand  side  of  the  screen  contains  two  tabs  which  display  diagnostic  information
about the clip.  The Analysis Summary tab shows the following pieces of information, which are applicable
to the entire clip:

The Analysis Summary tab

Status:  Shows  whether  the  HardingFPA-X  is  reviewing  results  or  in  another  state  such  as
loading/results/analysing/not loaded etc.

Video Source: The video standard of the analysis being viewed.

Filename:  The  filename  or  title  of  the  source  that  was  analysed  to  obtain  the  results  currently  being
displayed.

Analysis  Timecode:  The  timecode  of  the  final  frame  in  the  clip.  This  is  expressed  in  hours  :  minutes  :
seconds : frames.

Marked  Length:  The  length  of  material  currently  marked  off  with  Begin  and  End  markers.  This  is
expressed in hours : minutes : seconds : frames.

Recorded Length: The total length of the clip expressed in hours : minutes : seconds : frames.

Analysis Status: The Pass / Fail status of the clip with respect to the currently selected Flash and Pattern
guidelines.

Red Flash: The number of frames that exceed the test guidelines for red flash.

Spatial Patterns:  The number of frames that have exceeded the test guidelines for spatial patterns.

Luminance Flash: The number of frames that have exceeded the test guidelines for luminance flash.
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Extended  Failure:  The  number  of  frames  that  exceed  the  test  guidelines  for  extended  failure.  This
represents the number of frames for which the black trace has appeared or equivalently, the number of
times  that  the  maximum  allowed  number  of  flash  warnings  (levels  0.3  or  0.4)  in  the  most  recent  5
seconds has been exceeded.

In addition to this information, there is a second tab featuring Advanced Information.   This tab contains
detailed information corresponding to the individual frame at the current cursor position, and may be of
use in determining the build up to a failure.  The items described are as follows:

The Advanced Information tab

Luminance Diagnostic: This is the numerical value of the diagnostic plot shown on the graph. It represents
the minimum number of transitions which the most active 25% of the image frame has seen in the most
recent second.

Luminance Flash Area: The percentage area of the image frame which has exceeded the Flash Guidelines. 

Luminance Flash Contrast: The average contrast of the area of the image frame which has exceeded the
Flash Guidelines.

Extended Flash Warnings: The number of image frames which have generated flash warnings (levels 0.3
or 0.4) in the most recent 5 seconds.

Red Diagnostic: The number of red transitions which the most active 25% of the image frame has seen in
the most recent second.

Red Flash Area: The percentage area of the image frame which has exceeded the Red Flash Guidelines.

Red Flash Contrast:  The average amplitude of flash to  and from saturated red of  the area of  the image
frame which has exceeded the Red Flash Guidelines.

Spatial  Pattern  Area:  The  percentage  area  of  the  image  frame  which  has  exceeded  the  Spatial  Pattern
Guidelines.

Spatial  Pattern Contrast:  The average contrast  of  the area of  the  image frame which has  exceeded the
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Spatial Pattern Guidelines.
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Frame Masks

The  HardingFPA-X  includes  visual  information  in  addition  to  the  results  images  in  the  form  of
Frame Masks. These mask images are overlaid on top of the frame images on the large image in
the top-left of the main screen and depict the locations of problem areas in the sequence, to aid
in the repair of failing sequences. 

When the results first appear on the graph, the large image in the top left hand side will appear
as usual.  In order to utilise the frame mask images,  Click on the Frame Mask menu, and select
the type of failure that you want to see the mask overlaid for:

When any of the frame masks are chosen from this box, the images will change and the mask will
be overlaid onto a darkened, black-and-white (monochrome) version of the original frame
image. An example is shown below:

The colours represent the number of transitions which each pixel has experienced in the most
recent second after allowing for motion. The analyser will issue a failure when more than one
quarter of the image contains red or purple pixels. The same colour coding (shown below) is
used for both luminance and red flash analysis.

Pixel Colour Number of Transitions

none 0

green 1 or 2

yellow  3 or 4  

orange 5 or 6

red 7 or 8
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purple 9 or more

The spatial pattern mask data logs the activity which exceeds the spatial guideline limits as
shown below. 

The mask data appears as a set of uniformly coloured tiles in the image which represent how
long they have persisted in the image sequence. Spatial mask data only appears for stationary,
regular patterns which lead to failure. Any spatial patterns which drift, or are not regular, or do
not persist in the video long enough to trigger a failure are excluded. 

Pixel Colour Persistence

none no regular stationary pattern present

green 0 to 1/6 second

yellow  1/6 to 1/3 second

orange 1/3 to 1/2 second

red more than 1/2 second = FAILURE

purple outside of pattern regularity limit

The actual colours used represent how close the spatial pattern is to causing a failure rated in
terms of how long the pattern has persisted in the image sequence. When running under Ofcom
guidelines, the HardingFPA-X analyser will only tolerate illegal spatial patterns to persist for up to
half a second -- any longer than this will lead to a failure. Therefore the green, yellow and orange
colours denote the build up to failure while red represents the actual failure itself. Purple is
reserved for tiles which are part of the detected spatial pattern but whose pattern
characteristics lie outside of the allowable range when compared with the rest of the spatial
region. These purple tiles do not represent persistence and can accompany spatial masks of any
colour. 

It is important to note that the HardingFPA-X only presents mask colours for pixels which will go
into failure.  This allows the editor to focus on the region(s) of the image which lead to the
failure rather than flooding the user with unnecessary information. As a result, many images will
contain no masked / coloured pixels even though there may be some flash or pattern activity
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occurring. 

In addition, frame mask activity may suddenly disappear after an isolated failure sequence if the
remaining pixel transition activity does not lead to a subsequent failure. 
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It  is  important  to  note  that  when comparing  results  between  material  re-encoded  at  a  different  frame
rate,  then  the  number  of  failed  frames  will  differ,  and  the  results  may  differ  as  a  result  of  the  extra  /
missing frames that were introduced during the conversion process.

The  following  items  are  phenomena  commonly  seen  in  the  results  along  with  explanations  for  the
behaviour.

1) A flash occurred but the normal flash risk trace didn’t appear – The main flash risk trace (dark green
line)  may not  appear if  flashing is  less  than 20cd/m2  in contrast  or  if  the  flash  frequency is  significantly
within guideline limits. Remember that 2 opposing transitions make up a single flash.

The example below shows that  two transitions have been detected by the diagnostic  trace  (light  green
line) but that the main risk trace has not yet appeared because the flash frequency up to this point is not
considered to be significant.

(1) Showing a flash but no flash risk trace

2)  The  flash  risk  trace  (dark  green  line)  appeared  close  to  the  pass-fail  limit  for  a  long  sequence  of
images but didn’t enter the fail  zone  –  The system has detected flashing of  above 3Hz and 20cd/m2  in
amplitude; but the flash area is less than 25% of the screen area.  If the criteria for failure are not all met
then the system will generate a line based on how close the material is to failure.  If the line is hovering
just below the failure line then it might only need a tiny change in size of the flashing area to push it into
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failure.  Such a tiny change could be introduced when converting between formats, frame rates or codecs
if this is not done carefully using professional grade codecs.

The example  below shows that  the  flash  risk  has  remained  close  to  the  failure  line  for  long  enough  to
generate an extended flash  failure.  This  occurs  whenever  more  than 80% of  the  frames  in  the  last  five
seconds generated flash risk warnings of 0.3 or 0.4 (i.e. close to failure).

(2) Long sequence of flashing that eventually led to an Extended Flash Failure

3)  The  flash  risk  trace  (dark  green  line)  persists  for  several  frames  after  a  flash  occurred  –  This  is
perfectly normal,  and arises because of the way the system has to  detect  flashing frequencies over  the
most recent second.  You do not need to worry about the persistence of the flash risk traces, you need to
principally examine the second before the line moves into failure, or where the diagnostics trace shows
that the transition count is still rising.  Once you have corrected all the causes of the line first moving into
failure  then  the  material  at  that  point  will  pass  the  test.   Note,  however  that  lots  of  flashing  close
together will generate a much longer compound failure: the best thing to do is deal with the flashes one
at a time until the material passes the test.
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(3) Flash graph persisting after the flash.

4) The diagnostic transition count increased where no obvious flash had occurred – The diagnostic trace
represents  the  number  of  transitions  seen by  the  most  active  25%  of  the  screen  over  the  most  recent
second. Therefore continuous image activity (e.g. localised flashing and rapid movement within the scene
caused by camera pan or zoom etc) can steadily increase the number of transitions that individual pixels
have  seen,  and  when  at  least  25%  of  those  have  seen  an  extra  transition  will  the  diagnostic  count
increase. This can be quite tricky material to fix, and may only be possible by reducing the brightness of
the image or cut down on the whole area.
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(4) Transition count (light green trace) increased without an obvious transition

5) A flash clearly occurred but the diagnostic trace didn’t increase – The diagnostic trace shows the
number of transitions seen in the last second of material, and transitions older than that will be
discarded. This means that the diagnostic count may not always coincide with an obvious flash.  For
example, a visible transition in an image may not lead to a higher transition count if the pixels that see the
transition are not part of the most active 25%. 
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(5) A flash clearly occurred but the diagnostic trace hasn’t increased.

Alternatively,  an incoming transition may coincide with an outgoing  transition from one exactly  second
earlier. When this occurs, the new version 3 analyser inserts a squiggle (see picture with inset) to indicate
that  the  diagnostic  trace  has  simultaneously  gained  and  lost  a  transition  over  the  most  recent  second
between video frames. 
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6) The spatial pattern trace remains in the pass zone even though the detected spatial pattern exceeds
contrast and screen area limits – A number of limits have to be exceeded before a detected spatial
pattern can generate a failure. The Advanced Information tab in the example below shows that a spatial
pattern has been detected with 50 cd/m2 contrast (limit 20 cd/m2) and covers 46% screen area (limit
40%). However, in this example, the system has not generated a failure because motion, caused by the
camera pan and zoom, makes the detected spatial pattern exempt from failure under Ofcom rules.

7)  The diagnostic  trace decreased within a few frames after  it  had increased.  Shouldn’t  it  have taken
one  second  for  the  transition  to  flush  out?   --  Not  necessarily.   It  is  true  that  the  diagnostic  trace
monitors  transitions  over  the  most  recent  second  but  the  most  active  pixels  that  determine  this
diagnostic  count  are,  in  most  cases,  constantly  changing.  The  diagnostic  trace  will  only  follow  this
one-second pattern if the most active pixels are changing together in phase.

The example below shows the diagnostic trace (light green) increasing from zero to one for a period of
only two frames (around the vertical amber current frame line) before returning to zero.
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8)  The system passes a stationary pattern that looks as  though it  should have failed  –  Some patterns
that  are  clearly  bar-like  in  one  direction  may  also  possess  some  local  structure  in  the  orthogonal
direction.   Alternatively,  a  pattern  may  not  be  sufficiently  regular  or  may  not  have  sufficient  contrast
throughout. Any such structure may cause the system to see fewer than 6 light-dark bars or may separate
a  provocative  pattern  into  two  or  more  regions.  Either  of  these  mechanisms  can  save  a  provocative
pattern that would otherwise have failed.

The spatial pattern in the example below passes because of text and foreground objects which break up
the bar-like pattern into smaller irregular regions. 
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9) The analyser generates spatial warnings but it’s not obvious where the pattern is! – Occasionally the
spatial  trace  may  appear  when  there  is  no  obvious  spatial  pattern  present  in  the  video  stream.  The
example  below shows a  picture  of  the  sea  generating  spatial  warnings  caused  by  waves  in  perspective
creating  faint,  repeating  structure.  Other  candidates  for  generating  unexpected  spatial  responses  are:
landscape in perspective, net curtains and reams of paper. However, it is highly unlikely that any of these
scenes would actually lead to a spatial pattern failure.
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10) Scene Changes (Japanese NAB Analysis only) - When analysing under Japanese NAB guidelines, it is
possible for the flash risk trace to go into failure while the diagnostic trace is still in the caution zone (see
image). T his can occur if one of the transitions in the most recent second is classified as a “scene change”
(see bottom entry of the Advanced Information tab) where 80% of the image has seen a significant
luminance transition of 20IRE units or more. When this occurs, the maximum allowable number of
transitions is reduced from 6 down to 3 and, in this example, failure took place when the 4th transition
was detected.

 



Page 39

 © 2010 Cambridge Research Systems Ltd.

HardingFPA-X User's Manual

The Results Menu

Within  the  Results  menu are  the  controls  for  navigating  the  results  graphs  and  thumbnails  and  playing
back sections of video (only available where images are present – images are only written to the results
files in areas of interest, for example around failures).

The Viewer’s Results menu

Advance to Next Failure and Go Back to Previous Failure will perform the same action as the ‘seek right’
and ’seek  left’ arrow buttons on the bottom right corner of the screen, taking the cursor position to the
next or previous failure area.

The following menu items provide the ability to play back the images in various ways:

Start Replay:  Starts playback in real-time from the current position.

Stop Replay: Stops all playback.
  
Replay one second before and after cursor:  Animate the images for one second before and one second
after the current cursor position whilst leaving the graph positioned at the current cursor position.  This is
especially useful when you are looking for the causes of a particular failure and need to look at the graph
in detail and yet still see the offending section being played back.

Replay marked region: Replays from the Start marker to the End Marker.  Set marker positions by either
right-clicking on the graph or pressing the Page Up and Page Down keys or by clicking on Set Results Start
and Set Results End in this menu.

In all playback modes, the playback will loop when reaching the end (after a small pause).  The playback
can be  stopped at  any  time with  the  Stop Playback  menu item or  button,  by  clicking  anywhere  on  the
graph, by dragging the seek slider or by opening a new file.
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Licence Terms

HardingFPA-X Client applications use the Silk icon set from http://www.famfamfam.com/lab/icons/silk/

http://www.famfamfam.com/lab/icons/silk/
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